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nüvi 310/360 Owner’s Manual iii

INTRODUCTION
Thank you for buying the nuvi 310/360.

About This Manual
To get the most out of your new navigation system, take time to read this manual and 
learn the operating procedures for your unit in detail. This manual is organized into 
the following chapters. 

The Introduction contains the Table of Contents. 

The Getting Started section...

The Basic Operation section...

The Main Pages contain...

The Appendix contains information such as specifications, optional accessories, 
and maintenance information. You can also find warranty and FCC information in 
the Appendix. Read the Safety Information to learn how to install and use your 
Garmin GPS safely and responsibly. 

The Index ... 
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Product Registration
Help us better support you by completing our online registration today! Have the 
serial number of your nüvi handy, and connect to our Web site at  
http://www.garmin.com. Click the Product Registration link.

Use this area to record the serial number (8-digit number located on the back of the 
box) in case your nüvi is lost, stolen, or needs service. Be sure to keep your original 
sales receipt in a safe place, or attach a photocopy inside the manual.

Serial Number: ___ ___ ___ ___ ___ ___ ___ ___

Contact Garmin
If you encounter problems while using your GPS unit, or if you have any questions, in 
the U.S.A. contact Garmin Product Support by phone: 913/397.8200 or 800/800.1020, 
Monday–Friday, 8 AM–5 PM Central Time; or go to http://www.garmin.com/support/, 
and click Product Support.

In Europe, contact Garmin (Europe) Ltd. at 44/0870.8501241.
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Caring for the Unit
The nüvi case is constructed of high quality materials and does not require user 
maintenance except cleaning. 

Cleaning the Case 
Clean the nüvi’s outer casing (except for the screen) using a cloth dampened with a 
mild detergent solution and then wipe dry. Avoid chemical cleaners and solvents that 
may damage plastic components.

Cleaning the Screen
The nüvi screen should be cleaned using a soft, clean, lint-free cloth. Water, isopropyl 
alcohol, or eyeglass cleaner can be used if needed. If these are used, apply the liquid 
to the cloth and then gently wipe the screen with the moistened cloth.

Storage
Do not store the nüvi where prolonged exposure to temperature extremes may occur 
(such as in the trunk of a car) as permanent damage may result.
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Failure to avoid the following potentially hazardous situations may result in injury or 
property damage.
The nüvi is designed to provide you with route suggestions. It does not reflect road closures 
or road conditions, traffic congestion, weather conditions, or other factors that may affect 
safety or timing while driving.
Use the nüvi only as a navigational aid. Do not attempt to use the nüvi for any purpose 
requiring precise measurement of direction, distance, location, or topography. This product 
should not be used to determine ground proximity for aircraft navigation. 
The Global Positioning System (GPS) is operated by the United States government, which is 
solely responsible for its accuracy and maintenance. The government’s system is subject to 
changes which could affect the accuracy and performance of all GPS equipment, including 
the nüvi. Although the nüvi is a precision navigation device, any navigation device can be 
misused or misinterpreted and, therefore, become unsafe.
This TFR Overlay Display System (TODS) is updated Monday–Friday, 1200–2000 UTC. 
CONFIRM DATA CURRENCY THROUGH ALTERNATE SOURCES AT OTHER TIMES. 
For interpretation of this TFR contact your local FSS.

Caution
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Map Data Information: One of the goals of Garmin is to provide customers with the most 
complete and accurate cartography that is available to us at a reasonable cost. We use a combination 
of governmental and private data sources, which we identify in product literature and copyright 
messages displayed to the consumer. Virtually all data sources contain inaccurate or incomplete data 
to some extent. In some countries, complete and accurate map information is either not available or 
is prohibitively expensive.
Notice to State of California Drivers: California Vehicle Code Section 26708 (a) (1) provides that 
“No person shall drive any motor vehicle with any object or material placed, displayed, installed, 
affixed, or applied upon the windshield or side or rear windows.” Drivers in California should 
not use the suction mount on their windshield or side or rear windows. Garmin does not take any 
responsibility for any fines, penalties, or damages that may be incurred as a result of disregarding 
this notice. A disk for attaching the suction mount to a vehicle’s dashboard is enclosed.

New Nuvi 310,360 OM.indd   4 2/24/2006   5:06:21 PM



nüvi 310/360 Owner’s Manual 1

 

Turning Your nüvi On or Off
To turn your nüvi on or off, press and hold the Power button  on the top of the unit. 
The fi rst time you turn on your nüvi, follow the on-screen, set-up instructions.

Charging Your nüvi
To charge the nüvi:
Connect your nuvi to the suction mount and the 12/24-volt car adapter.
OR
Connect your nuvi to the USB cable and your computer. 

Resetting Your nüvi
If your unit locks up (freezes up), press the Power button to turn off the unit, then 
press again to turn the unit back on. If this does not help, reset your nüvi. 

To reset the nüvi:                        ➊

➋

1. Raise the antenna.
2. Press the Reset button.                
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 Clearing   User Data
Hold your fi nger on the upper right corner of the nüvi’s screen while turning on the 
nüvi. Keep your fi nger pressed until the pop-up window appears. Touch Yes to clear 
all user data. 

All original settings are restored. Your Recent Selections and audible bookmarks are 
also deleted. 

 Adjusting the  Volume and  Brightness 
Press and quickly release the Power button or touch 

Brightness
 on the Menu page to access 

the  Quick Settings. Move the sliders to adjust the  volume and  brightness. Touch  Mute 
to turn the volume off. 

Locking the Screen
To prevent accidental screen taps, touch Lock. To unlock the screen, press the Power 
button. 
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nüvi Tips and Shortcuts
• To quickly return to the Menu page, press and hold Back.

• To learn more about the nüvi’s Bluetooth or Travel Kit features, touch the Help 
button on the appropriate screen. 

• To jump from any page back to the player page when you are listening to music or 
an audible book, quickly press the Power button twice. Press Back to return to the 
previous page you were viewing (such as the map). 

• To extend the battery life, close the antenna when you do not need to receive  GPS 
signals. If the antenna is closed, the GPS receiver is turned off. 

• To access the Quick Settings, quickly press and release the Power button. 

 • To adjust the volume and brightness, move the sliders . You can also touch  
  on the Menu page to adjust the levels.

 • To prevent accidental screen taps, touch Lock. To unlock the screen, press the  
  Power button and touch Unlock. 
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Mounting Your nüvi
For a tight grip, clean and dry your windshield and the suction cup with a lint-free 
cloth before mounting the suction cup. 

To mount the suction cup mount:
1. Place the suction cup on the windshield. 
2. Flip the lever back, toward the windshield. 
3. Open the antenna. Fit the bottom of your nüvi into the cradle.
4. Tilt your nüvi back until it snaps in place. If necessary, rotate the cradle. 
5. Plug the small end of the cable into the back of the mount; plug the other end 

into a 12/24-Volt receptacle in your vehicle.
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➋

➊ Windshield

➎

➍

➌ Microphone 
jack

If you are using the external microphone (optional), plug the microphone into the right 
side of the nüvi cradle.

To remove your nüvi from the cradle, press the small tab on the bottom of the cradle 
up, and tilt the nüvi forward. 
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Finding Your Destination
Flip up the antenna on the nüvi to get satellite signals. Then, use the Garmin nüvi to 
fi nd your destination and go to it.

Select a category. Touch 
the arrows to see more 
categories. 

Select a destination. 
Touch the arrows to see 
more places. 

Enjoy the route! Touch .

Touch  Where to? 
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Following Your Route
Follow the route to your destination using the Map page. As you travel, the nüvi 
guides you to your destination with voice prompts, arrows on the map, and directions 
at the top of the Map page. If you depart from the original route, the nüvi recalculates 
the route and provides new route instructions. 

Your route is marked with 
a magenta line.

Follow the arrows as you 
take turns.

A checkered flag marks 
your destination.

For more information about using the Map page, see pages xx. 

 NOTE: You can add only one via point to your route.
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Viewing the Map Page
From the Menu page, touch 
Viewing the Map Page

 View Map to open the Map page. The position icon 
 shows your location. Touch and drag the map to view different areas. 

Map Page while Navigating a Route

Touch Arrival or 
Speed to open the Trip 

Touch Turn In to open 
the Next Turn page. 

Touch the text bar to 
open the Current Route 

page. 

Touch  to zoom out.

Touch  to zoom in.
Touch Menu to return 

to the Menu page.

 GPS  Satellite Signals
The  bars in the upper left corner represent the 
satellite signals being received by your nüvi. When you see 
 green bars, you have a strong signal. See page xx for more 
information 
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Adding Stops to Your Route
You can add a stop (via point) to your route. The nüvi gives you directions to the via point 
and then to your fi nal destination. With a route active, touch Menu >  Where to? 

With a route active, touch 
Menu >  Where to? 

➊

Search for the extra stop.

➋

Touch .

➌

Touch Yes to add 
this stop before your 
destination. 

➍
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Setting a Home Location
You can set a Home location for the place you return to most often. After you have set 
your Home, you can easily  Go Home.

Touch Set Home.Touch  Where to? > 
 My Locations.

Select an option. 

Going Home
Once your Home location is set, you can route to it at any time by touching My 
Locations and then Go Home.

Changing Your Home Location
Change your Home location by repeating the steps above. 
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Editing Saved Places
After you save a place, you can change the name of the place and its symbol on the 

map. From the Menu page, touch 

After you save a place, you can change the name of the place and its symbol on the 

 Where to? >   My Locations.

Touch  Favorites. 

➊

Touch a button to change 
the name or the map 
symbol, or to delete the 
item. 

➍

Touch the Edit button. 
The Edit window opens.

➌

Select the place you want 
to edit.

➋
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Changing the Name
To change the name, touch Change Name. Enter the new name using the on-screen 
keyboard. Touch Done. 

Changing the Map Symbol
To change the symbol used on the map, touch Change Map Symbol and select a 
symbol from the list. 

Deleting Saved Places
To delete this saved place, touch Delete. Then touch Yes. 
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Finding a Place  Using the  Map
Touch and drag anywhere on the Map page to browse the map and view different parts 
of the map. You can also touch 
Touch and drag anywhere on the Map page to browse the map and view different parts 

 Where to? > 
Touch and drag anywhere on the Map page to browse the map and view different parts 

 Browse Map. 

Tips for  Browsing the Map
• Touch the map and drag to view different parts of the map. 
• Use the  and  icons to   zoom in and out. 
• Touch any object on the map. An arrow appears pointing at the object you 

selected. 
• Touch Go to navigate to the selected location. 
• Touch Save to save this location to your Favorites. 
• If the GPS if turned off, touch  Set Loc. to set your location to the selected 

location. 
• Touch Back to return to the previous screen.
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Viewing Places on the Map
You can view a place you have found on the Map page. 

Drag the map and zoom 
in or out as necessary. 
Touch Back when you 
are done. 

➋

Touch Show Map.

➊
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 Expanding Your Search

Select an option. Touch 
OK.

➋

From the Menu page, 
touch  Where to? 
Then touch   Near.

➊

Where I Am Now—searches for places near your current location. 

A Different City—searches for places near the city you enter. 

My Current Route—searches for places along the route you are currently navigating.

My Destination—searches for places near your route destination.

 NOTE: Your nüvi automatically searches for places near your current location. 
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Saving Places You Find

After you have found a place 
you want to save, touch 
Save. 

Touch OK in the pop-up window. The place is saved in 
 My Locations > Favorites. 

Finding Saved Places

Touch .From the Menu page, 
touch 
From the Menu page, 

 Where to? > 
 My Locations > 

Favorites. 

Select a place.
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WHERE TO?  
To learn how to perform a simple search using the  Where To menu, see page x. 

Finding a Place by  Spelling the Name 
From the Menu page, touch  Where to? > 

Spelling the Name 
 Spell Name.

Using the on-screen 
keyboard, enter letters 
contained in the name. 
Then touch Done.

➊

Select the place you want to visit.

Touch .

➋

Touch  to enter numbers. Touch  to  delete the last character entered; 
touch and hold  to delete the entire entry. 

Tip: In any search results list, if you do not see the place you want visit or you want to 
narrow your search results list, touch Spell and enter the name or part of the name. 
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Go! Page Options

Touch  to create a turn-by-turn route to this location. 

Touch Show Map to view this location on the map. 

Touch Save to save this location as one of your Favorites. See pages 9 through 12 
for more information. 
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  MY LOCATIONS 

Saving Places You Find 
➋

Touch OK. 

➊

After you have found 
a place, touch Save. 

Finding Saved Places 
From the Menu page, touch 

Finding Saved Places
 Where to? >   My Locations.

Select the place you 
want to visit.

➋

Touch  Favorites. 

➊

New Nuvi 310,360 OM.indd   19 2/24/2006   5:06:26 PM



Understanding My Locations
You can save all of your favorite places in My Locations. You can also save your 
home location in My Locations. 

Saving Your Current Location
Touch anywhere on the Map. An arrow points to your current location. Touch Save. 
Your current location is saved in your Favorites. 
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Trip Information Page
The Trip Information page displays your current speed and provides helpful statistics 
about your trip. To view the Trip Information page, select Speed or Arrival on the 
Map page. 

Current direction 
 of travel

Distance traveled 
(Odometer)

Trip Information Page

Distance to your 
final destination

Resetting Trip Information
If you want accurate trip information, reset the trip information before beginning a 
trip. If you make frequent stops, leave the nüvi turned on so it can accurately measure 
elapsed time during the trip. 

Select Reset Trip to reset the information on the Trip Information page. Select Reset 
Max to reset the Maximum Speed.
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Current Route Page
The Current Route page displays turn-by-turn instructions for your entire route. Touch 
the green text bar on the top of the Map page to open the Current Route page. This 
page displays all turns in the route and the distance between turns. Select a turn on the 
list to view the Next Turn page for that turn. Touch Map to view the entire route on 
the map. 

Current Route Page

Direction of  
the turn

Distance to  
the turn

Upcoming turn

Distance to the upcoming turn

Approximate time left until this turn

Next Turn Page
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Next Turn Page
The Next Turn page shows the turn on the map and the distance and time left before 
you reach the turn. To view an upcoming turn on the map, select Turn In on the Map 
page, or select any turn from the Current Route page. 

Use the up and down arrows to view other turns in the route. When you are finished 
viewing the Next Turn page, select Back.
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Adding a Detour to a Route
If you need to take a detour from your current route, select Detour from the Menu 
page of the nüvi. The unit calculates a new route and provides you with new 
instructions. The nüvi attempts to get you back on your original route as soon as 
possible.

Select Stop to end navigation. 
Select Detour and your unit 
creates a new route if possible.

➋

Select Menu to return to the 
Menu page.

➊

On some routes, the route you are currently taking might be the only reasonable 
option. In this case, you cannot take a detour. 

Stopping Your Route
If you want to stop your current route, return to the Menu page and select Stop. 
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Finding an Address
From the Menu page, touch  Where to? >  Address. 

Select a state. Then 
select Search All.

Select the street. Select the address, if 
necessary. Touch .

➍

➌➊

Type the street name 
until a list of streets 
appears, or touch Done.

➏

Type the address 
number and touch 
Done. 

Select a city, if 
necessary.

➎

➋
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  NOTE: Finding an intersection is very similar to finding an address. Touch 
Intersection and enter the two street names. 
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Using BlueTooth® Technology
To use the Bluetooth technology of the nüvi, you must confi rm that your Bluetooth 
phone is supported by the nüvi. (See www.garmin.com/bluetooth/.) Then you must 
follow these steps to pair your phone with this nüvi.

Select your phone and 
touch OK, or touch Add 
Device and OK. 

If adding, set your phone to Find Me/Discoverable 
mode, and touch OK. Enter passkey 1234 on your 
phone, when prompted. The   Phone and 

 Bluetooth icons appear on the Menu page if the 
pairing is successful.

Touch  , and then 
touch Bluetooth. 

On the Menu page, 
touch 
On the Menu page, 

 Settings
Touch Add (or Change 
if you already added). 
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Placing a Direct Call
Ensure that your phone is paired with your nüvi. 

Touch Dial. Touch  Phone. Dial the number, and 
touch Dial. To end the 
call, touch , and then 
touch .
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If you are calling a number that requires that you enter information using a keypad 
during the call (for example, entering a password for your voicemail), do the 
following.

Enter the required 
information. Touch 
Back when you are 
finished.

Touch  during the 
call, and then touch 

. 

To end the call, touch 
, and then touch 

.
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Placing a POI Call
Ensure that your phone is paired with your nüvi. You can call a phone number for any 
POI (Point of Interest) that is listed on the nuvi.

Touch POI Dial. Touch the POI function 
that you want to use.

Touch  Phone.

Select a category. Select a POI from the list. Touch  to call the 
POI.  To end the call, 
touch  and then touch 

.
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Receiving a Call
Ensure that your phone is paired with your nuvi. When you receive a call, an 
“Incoming Call” message appears on the nuvi. Touch Answer. To end the call, touch 

 and then touch .
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Loading Items to Your nüvi
Connect the mini-USB connector to the side of the nüvi. Connect the larger end of the 
cable to an available USB port on your computer. 

Double-click the My Computer icon on your computer’s desktop. Two new 
Removable Disk drives appear in your list of drives: “nuvi” and “nuvi sd.” “nuvi” is 
the available storage in the nüvi’s internal memory. “nuvi sd” is the SD card inserted 
in your nüvi. If you do not have an SD card inserted in your nüvi, the “nuvi sd” drive 
does not appear in the list. 

Double-click one of the nüvi drives to open it. Copy and paste files into the drive. 

To disconnect, double-click the Unplug or Eject Hardware icon  from your 
Windows® system tray. Click Stop and then OK.
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Using an FM TMC Traffi c Receiver 
Using a Garmin GTM 10 or GTM 11 FM TMC Traffi c Receiver, the nüvi can receive 
and use traffi c information broadcast over the FM Radio Data System. For more 
information about these Garmin FM TMC Traffi c Receivers, visit http://www.garmin.
com/. 

Connecting the FM TMC Traffi c Receiver to Your nüvi
Place your nüvi into the mount, and plug it into the 12/24-volt adapter. Plug the USB 
cable from the GTM 10 or GTM 11 into the USB cable connector on the side of the 
nüvi 

Viewing Traffi c Events
From the Menu page, touch 
Viewing Traffi c Events

 to display a list of traffi c events. The traffi c symbols 
appear on the Map as well. 
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More Information
For more detailed information about the nüvi functions, connect your nuvi to your 
computer and refer to the owner’s manual located on your “nuvi” drive. The manual is 
also available on the Garmin Web site at http://www.garmin.com/products/nüvi/. Click 
the Manuals link, and then select Download. You must have Adobe Reader installed 
on your computer to view this manual.
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MANAGING   FILES ON YOUR NÜVI
Your nüvi is able to store fi les, such as JPEG images and MP3 music fi les. You can 
store fi les in the nüvi’s internal memory or on an optional SD Card. 

After you connect your nüvi to your computer, you can copy and paste fi les to the 
memory or an optional SD Card. Follow the four steps described below and on the 
next page.

Step 1: Insert an   SD Card (Optional)
The SD card slot is located on the side of the nüvi. To insert or remove the card, press 
it in until it clicks. 

Inserting an SD Card
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 Step 2:  Connect the  USB Cable 
1. Plug the small end of the USB cable into the connector located on the side of 

your nüvi. 
2. Connect the larger end of the USB cable to an available USB port on your 

computer. 

Connecting the USB Cable
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Step 3: Transfer Files to Your nüvi
1. Connect the nüvi to your computer as described on the previous page. 
2. Double-click the My Computer icon  on your computer’s desktop. 
3. Browse your computer for the file you want to copy. 
4. Highlight the file and select Edit > Copy. 
5. Open the “nuvi” or “nuvi sd” drive (see the next page for information).
6. Select Edit > Paste. The file then appears in the list of files on the nüvi 

memory or SD card. 

nüvi Removable 
Disk Drives

Step 4: Eject and Unplug the USB Cable
When you are finished transferring files, double-click the Unplug or Eject  icon 
in your system tray. Select “USB Mass Storage Device” and click Stop. Select the 
nüvi drives and click OK. You can disconnect your nüvi from your computer now. 
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Information about Your nüvi Drives
After you connect your nüvi to your computer, one or two additional drives appear in 
your computer’s list of drives: “nuvi” and possibly “nuvi sd.” 

“nuvi” is the available storage in the nüvi’s internal memory. “nuvi sd” is the SD card 
inserted in your nüvi. If you do not have an SD card inserted in your nüvi, the “nuvi 
sd” drive does not appear in the list. 

nüvi Removable 
 Disk Drives

 NOTE: On some Windows Operating Systems, the nüvi drives may not be named 
automatically. See your Windows help file or page 56 of this manual to learn how to 
rename the drives. 
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Additional Help
For troubleshooting tips for using the nüvi with your computer to transfer files, see 
page 55.

Deleting Files from Your nüvi
You can delete files from your nüvi just as you would delete files from your computer.

With the nüvi connected to your computer, open My Computer. Open your “nuvi” or 
“nuvi sd” drive. Highlight the file that you want to delete from your nüvi and press the 
Delete key on your computer’s keyboard. 

Supported File Types
• MP3 music files
• JPG image files
• AA audible book files
• GPI custom POI files from Garmin’s POI Loader (see page 51)
• GPX waypoint files from MapSource (see page 54)
• Maps from MapSource

 NOTE: The nüvi does not support iTunes M4A/M4P files. 

 CAUTION: If you are not sure about a file’s purpose, do NOT delete it. Your 
nüvi memory contains important map data files that should NOT be deleted. Be 
especially cautious of files located in folders entitled “Garmin.”
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USING THE  TRAVEL KIT 
The travel kit provides many features that are helpful when you are traveling across 
town or across the globe. Touch  Help to learn more about the nüvi Travel Kit. 

Touch the arrows to view all items in the Travel 
Kit. Touch the item you want to open. 

From the Menu page, 
touch 
From the Menu page, 

 Travel Kit. 
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Using the Language Guide 
The Garmin Language Guide puts data from Oxford’s multilingual resources and 
fi ve bilingual dictionaries in the palm of your hand. A sample version of the Garmin 
Language Guide is provided. To purchase the Garmin Language Guide accessory, 
go to the Garmin Web site at http://www.garmin.com/products/nuvi/ and click 
the Accessories link. You can also contact your Garmin dealer to purchase nüvi 
accessories. 

➊

From the Menu page, 
touch 
From the Menu page, 

 Travel Kit.

➋

Touch the arrows to view 
all items in the Travel Kit. 
Touch the item you want 
to open. 

 NOTE: Only nüvi 360 models can verbally translate words and phrases in the 
Language Guide. 

Loading the Language Guide
After you have received your Garmin Language Guide SD Card, you must load the 
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data on your nüvi. Follow the directions on the package or in the nüvi help file to learn 
how to load the data into your unit. 

 TIP: After you load the Garmin Language Guide onto your nüvi, you can use the 
SD card for other data, such as MP3s or Audible Books. 

All Dictionary, Word and Phrase content is © Oxford University Press. Voice 
files are © Scansoft.
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Translating Words and Phrases
From the Menu page, touch 
Translating Words and Phrases

 Travel Kit >    Language Guide.

➎

Search for a phrase and 
touch it. Touch  to hear the 

translation. 

➏➍

Select a category.

➊

Touch Words and 
Phrases.

➋

Touch Language.

➌

Select the From and To 
languages and touch 
Back.
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Words and Phrases Tips
• Use Keywords in Phrases to find all of the phrases that contain a specific 

word. 
• Touch Search to spell the word. 
• Touch an underlined word to replace the word. 
• Touch More Variations to change words in the phrase or get a different 

translation.
• If you cannot find what you are looking for in Words and Phrases, look in the 

Bilingual Dictionaries. 

SaversGuide® (Optional)
With the SaversGuide preprogrammed SD data card and membership card, your 
nüvi becomes a digital coupon book that notifies you of merchants near your current 
location where you are eligible for a discount such as restaurants, hotels, stores, 
dry cleaners, movie theatres, and auto repair shops. To purchase the SaversGuide 
accessory, go to the Garmin Web site at http://www.garmin.com/products/nuvi/ and 
click the Accessories link. You can also contact your Garmin dealer to purchase nüvi 
accessories.
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Using the  Bilingual Dictionaries
The Garmin Language Guide provides fi ve bilingual dictionaries. You can easily 
translate words and hear their pronunciation using the Bilingual Dictionaries. 

1. On the Menu page, touch  Travel Kit >    Language Guide.
2. On the Oxford page, touch Bilingual Dictionaries.
3. On the Select a dictionary page, touch a translation option. If necessary, touch 

To English.
4. On the Select Word page, search for the word and touch it.
5. On the Translation page, touch  to hear the word spoken.

Bilingual Tips
• Touch Search to spell the word or the beginning of the word. 
• Touch  Legend to view the legend for the selected language. The Legend contains 

information on abbreviations, labels, and pronunciation symbols used in each 
dictionary.
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Using the Travel Guide 
Much like a paper travel guide, the Garmin Travel Guide provides detailed 
information about places, such as restaurants and hotels. Your nüvi comes with a few 
sample travel guide points; to purchase the Travel Guide accessory, go to the Garmin 
Web site at http://www.garmin.com/products/nuvi/ and click the Accessories link. You 
can also contact your Garmin dealer to purchase nüvi accessories. 

1. From the Menu page, touch  Travel Kit > Touch  Travel Guide. 
2. On the Marco Polo page, touch Browse.
3. On the Select Sample Location page, touch a location.
4. On the Category List page, touch a category. Touch a sub-category, if 

necessary.
5. On the List page, touch an entry.
6. On the Information page, touch the arrows to view more information about the 

location. Touch Go to go to the location. Touch Map to display this item on a 
map.
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Listening to MP3 Files

Select a category. To play the entire category, 
touch Play All. To play one 
song, touch the title. 

Touch Back to exit the 
MP3 page to view other 
pages, such as the map. 

From the Menu page, 
touch 
From the Menu page, 

 Travel Kit. 
Touch  MP3 Player. Touch Browse.

Touch  to adjust the volume. 

Tap  to go to the beginning of the song; touch and hold to skip back. 
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Tap  to skip to the end of the song; touch and hold to skip ahead. 

Touch  to pause the song. 

Touch  to repeat. Touch  to shuffl e. 

When you are listening to music or an audible book, quickly press the Power button 
twice to jump from any page back to the player page. Press Back to return to the 
previous page you were viewing (such as the map). 

 NOTE: The nüvi plays  MP3 fi les only: it does not support iTunes  M4A/M4P fi les. 

Playing Audible Books
Your nüvi provides sample Audible books, which are only portions of the book. 
Purchase full books from Audible.com at http://garmin.audible.com. 

1. On the Menu page, touch   Travel Kit >  Audible Book Player.
2. Touch Browse.
3. Touch a book title.
4. Touch  .

Touch  to adjust the volume. 

Tap  to jump back. Tap  to skip ahead. Press and hold to move more quickly. 

Touch  to pause the book. 

Touch the book cover art to view book information. 
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When you are listening to music or an audible book, quickly press the Power button 
twice to jump from any page back to the player page. Press Back to return to the 
previous page you were viewing (such as the map). 
Using Bookmarks
To create a bookmark, touch  and Bookmark. To view your bookmarks, touch 

 and then touch a bookmark. Touch  to listen to the book from the bookmark. 

Moving around the Book

Touch 

Moving around the Book

 to skip a section and  to jump back. 

Press and hold  and  to move forward or backward through the book. 

Touch the book cover art to view information about the book. 

Loading Audible Books to Your nüvi
To purchase a book, go to http://garmin.audible.com and create an Audible.com 
account. After you create an account, download AudibleManager to your personal 
computer. Then you can purchase a book and download it to your nüvi. 

Before you can listen to an audible book, you must activate your nüvi. The fi rst time 
you open AudibleManager, you are led through the activation process. See page 29 for 
more information. 

After activating your nüvi, follow these three steps to load an audible book to your 
nüvi: connect your nüvi to your computer, download the book to your computer, and 
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transfer the book to your nüvi. 

Step 1: Connect your nüvi to the computer
1. Connect the mini-USB connector to the side of the nüvi. 
2. Connect the larger end of the cable to an available USB port on your computer.
3. If you want to load the book on your SD card, insert the SD card in the slot in 

your nüvi. 

Step 2: Download the book to your computer
Refer to AudibleManager’s Help file for detailed instructions about downloading 
books to your computer and loading them on your nüvi. 

1. From your computer’s desktop, double-click the AudibleManager icon to open 
AudibleManager. 

2. Click the Go to My Library Online  button on the top center of 
the window. Your Audible.com library opens, displaying the books you have 
purchased.

3. Click Get it Now to download the book to your computer. 
4. Select a format and click Download.

Step 3: Transfer the book to your nüvi
Refer to AudibleManager’s Help file for detailed instructions about downloading 
books to your computer and loading them on your nüvi. You must first activate your 
nüvi before transferring books: see page 29. 

1. Open AudibleManager. 
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2. Select the Internal Drive or External Drive (SD card) in the lower portion of the 
window. 

3. Select the book title. Click the Add to Garmin - nüvi  button in the 
top left corner.

4. Select how much of the book you want to load. You can load small sections at 
a time to save memory. Click OK. AudibleManager transfers the book to your 
nüvi. 

5. When you are finished, double-click the Unplug or Eject Hardware icon . 
Click Stop and then OK.

AudibleManager Program

Books in your 
AudibleManager 

library

Book loaded 
on your nüvi

Add to Garmin -  
nüvi icon

Go to My Library 
Online icon

Activating Your nüvi with AudibleManager
Before you can listen to a book you have downloaded from Audible.com, you must 
activate your nüvi. This is a one time process.  
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1. Disconnect your nüvi from your computer: double-click the Unplug or Eject 
 icon in your system tray. Select “USB Mass Storage Device” and click 

Stop. Select the nüvi drives and click OK. Unplug the USB cable from your 
nüvi. 

2. From your computer’s desktop, double-click the AudibleManager icon to open 
AudibleManager. 

3. In the “Choose your device” window, click the box next to “Garmin - nüvi” to 
place a check mark in the box. Click Next.

4. Enter your Audible user name and password. Click Next.
5. Connect your nüvi to your computer using the USB cable. Wait a few moments 

for AudbleManager to detect your nüvi. 
6. Select Activate my player(s) and click Next.
7. Please wait while AudibleManager attempts to activate your nüvi. Upon 

completion, you will receive a message saying the process has been 
successful. Click Finish.

 NOTE: If you are unable to connect to the Internet or have any other problems 
activating your nüvi, refer to the Audible Manager Help File. Select Help from the 
menu and then click Help. 
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Viewing  Pictures 
You can view pictures that you have stored in your nüvi using the Picture Viewer.

1. On the Menu page, touch  Travel Kit. 
2. Touch  and then  Picture Viewer.
3. Touch a picture to view a larger image of it.
4. Touch  and  to scroll through the images. 

Viewing a Slide Show
Touch Slide Show to start a slide show, which displays each image for a few moments 
and then displays the next image. 

Touch anywhere on the screen to stop the slide show. 

 TIP: Touch Rotate to rotate the image 90°. 

Using the World  Clock 
1. From the Menu page, touch  Travel Kit.
2. Touch  and then touch  World Clock.
3. To change a city listed, touch the city. 
4. Select a new time zone (or city). Touch OK when done. 
5. Touch World Map to view a map.
6. Nighttime hours are shown in the shaded area. Touch World Clock to view the 

clocks again, or Back to exit.
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Converting   Currency 
1. From the Menu page, touch  Travel Kit. Touch  and then  

Currency Converter. 
2. Touch to change the currency.
3. Select a currency and touch OK. 
4. Touch to change the currency.
5. Select a currency and touch OK. 
6. Touch the blank rectangle under the currency rate you want to convert.
7. Enter the number. Touch Done. 
8. Touch Clear to convert a different value.

 Updating Conversion Rates
The nüvi allows you to update the currency rates manually so that you are always 
using the most current conversion rates. 

1. From the Menu page, touch Travel Kit. Touch  and then  Currency 
Converter. 

2. Touch Update.
3. Touch the rate you want to update. 
4. Touch  to erase the current rate. Enter a new rate and touch Done. 
5. Touch Save to fi nish. 

 TIP: Touch Restore to use the original conversion rate. 
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 TIP: Touch and hold  to erase the entire entry.

Converting  Measurements 
1. From the Menu page, touch Travel Kit. Touch  and then  

Measurement Converter. 
2. Touch the button.
3. Select a type of measurement and touch OK.
4. Touch From or To. 
5. Select a unit of measure and touch OK.
6. Touch the blank rectangle to enter a value. 
7. Enter a value and touch Done.
8. Touch Clear to enter another measurement.

Using the  Calculator 
1. From the Menu page, touch Travel Kit. Touch  twice and then  

Calculator. 
2. Enter the fi rst number of your calculation. 
3. Touch an operator (÷, x, -, or +). 
4. Enter the second number of your calculation. 
5. Touch =. 
6. Touch  to make a new calculation.

Touch . to add a decimal. 
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Touch ± to make the number negative or positive. 

Touch % to make the number a percent (0.01). 

Touch  to clear the entry. 

 CUSTOMIZING THE NÜVI

To  change nüvi settings, touch  from the Menu page. See the following pages for 
more information.

1. On the Menu page, touch  .
2. Select the setting you want to change. 

Restoring Settings
To restore all settings you have changed, press the Restore Settings button, as shown 
below. 
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To restore settings for an individual category, such as Map, touch the Restore Settings 
button on that particular page. 

Changing the Map Settings
Map Detail—adjust the amount of detail shown on the map. Displaying more detail 
causes the map to redraw slowly. 

Map View—change the perspective of the Map page. 

• Track Up—display the map in 2 dimensions (2D) with your direction of travel 
at the top.

• North Up—display the map in 2D with North at the top.
• 3D View—display the map in 3 dimensions (3D), Track Up orientation. This is 

the default map view.
Map Info—view the maps loaded on your nüvi and their version. 

Restore—restore the original map settings.

Changing the System Settings
WAAS/EGNOS—enable and disable WAAS/EGNOS. For information about WAAS, 
go to http://www.garmin.com/aboutGPS/waas.html.

Units—change units of measure to kilometers (Metric) or miles (Statute). 

Safe Mode—disable or enable the Safe Mode feature to improve driver safety. When 
your vehicle is moving, Safe Mode disables all unit functions that require significant 
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operator attention and could become a distraction while driving. 

Touch Tones—disable or enable the tone that sounds each time you touch the screen.

Proximity Alarms—disable or enable the alerts when you approach Custom POIs. 
This option is only visible if you have loaded Custom POIs. See page 51 for more 
information about Custom POIs. 

About—display your nüvi’s software version number, unit ID number, and audio 
version number. This information is needed when you update the system software (see 
page 53) or purchase additional map data (see page 54).

Restore—restore the original system settings.

Changing the Time Settings
Time Format—choose a 12-hour, 24-hour, or UTC time format.

Time Zone—select a time zone or nearby city from the list. 

Daylight Saving—set to On, Off , or Auto if it is available.

Restore Settings—restore the original time settings.

Changing the Display Settings
Color Mode—select Daytime for a light background, Nighttime for a black 
background, or Auto to automatically switch between the two. 

Backlight Timeout—select the length of time the backlight stays on after external 
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power is removed. Reducing the time the backlight stays on increases your battery 
life. 

Touch Screen—recalibrates (or realigns) the touch screen to respond properly. Touch 
Recalibrate and then follow the directions. 

PictureIt—enables you to take a screen shot when you quickly press and release the 
Power button. The screen shots are saved in the “PictureIt” folder on your “nuvi” 
drive. 

 NOTE: When PictureIt is On, the Quick Settings screen does not open when you 
press the Power button. 

Changing the Navigation Settings
Route Preference—select a preference for calculating your route. Select Faster Time 
to calculate routes that are faster to drive but can be longer in distance. Select Shorter 
Distance to calculate routes that are shorter in distance but can take more time to 
drive.

Vehicle—specify your vehicle type to optimize routes. 

Avoidances—touch the Enabled button to access the road types. Select the road types 
you want to avoid on your routes. The nüvi uses these road types only if alternative 
routes take you too far out of your way or if no other roads are available. If you have 
an FM TMC Traffic Receiver, you can also avoid traffic incidents.

Attention Tone—turn on or off the attention tone.
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Voice Prompts—select when you want to nüvi to announce route navigation and 
system status. 

Restore Settings—restore the original navigation settings.

Changing the Language Settings
Text Language—change all on-screen text to the selected language. Changing the 
Text Language does not change the language of map data, such as street names and 
places or user-entered data. 

Voice Language—change the language for all voice prompts and messages. 

 If you have a nüvi 310, your nüvi contains pre-recorded voices that have a 
limited vocabulary and do not speak names of locations or streets.

 If you have a nüvi 360, your nüvi contains text-to-speech (TTS) voices: for 
example, American English-Jill is a text-to-speech voice. The text-to-speech 
voices “read” and “speak” the same words that are displayed on the nüvi. The 
voices have an extensive vocabulary, and they pronounce the street names as 
you approach turns. 

Restore Settings—restore the original language settings.
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  FM TMC TRAFFIC INFORMATION 
Using an optional Garmin FM TMC Traffi c Receiver, your nüvi can receive and use 
traffi c information broadcast over the FM Radio Data System (RDS). When a traffi c 
message is received, your unit displays the event on the map and can change your 
route to avoid the traffi c incident. For more information about the FM TMC Traffi c 
Receiver, visit the Garmin Web site (www.garmin.com). For participating subscription 
providers, refer to the Garmin Web site at http://www.garmin.com/fmtraffi c. 

Connecting the FM TMC Traffi c Receiver to Your nüvi
Place your nüvi in the auto mount and plug into the 12-volt adapter. Plug the Traffi c 
Receiver’s mini-USB cable into the mini-USB connector located on the side of the 
nüvi. 
 NOTE: You can only access the traffi c information and settings if the nüvi is 

connected to external power and an FM TMC Traffi c Receiver, such as a GTM 10. 

Connecting the FM TMC Traffi c Receiver to the nüvi
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Viewing Traffi c  Events
1. From the Menu page, touch .
2. Select an item to view details.
3. Select an option.

Avoiding  Traffi c
The map page displays a  when there is a traffi c event on your current route or on 
the road you are driving. When you are following a route, touch the  to avoid the 
traffi c. 

1. From the map page, touch .
2. Select an item to view details.
3. Touch Avoid.
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Traffi c Symbols

North American Symbols Meaning International Symbols

Road Condition

Road Construction

Congestion

Accident

Incident

Information

Color Code
The bars to the left of the traffi c symbols indicate the severity of the traffi c incident:

 = Low severity; traffi c is still fl owing.

 = Medium severity; traffi c is a bit congested.

 = High severity; traffi c is heavily congested or stopped. 
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Traffi c Events List

Color code
Traffi c Symbol

Adding a   Subscription
Your FM TMC Traffi c Receiver may have a trial subscription, or you may be in an 
area with free service. You can also add subscriptions to expand your service area. 
You will need your FM TMC Traffi c Receiver’s Unit ID; see below for directions. 
Go to http://www.garmin.com/fmtraffi c to purchase a traffi c subscription and obtain a 
25-character traffi c subscription code. 

1. From the Menu page, touch .
2. Touch Setup.
3. Touch Add. 
4. Touch Next. 
5. Enter the code and touch Done.
6. Touch Done.
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APPENDIX

Mounting the nüvi on Your Dashboard
Use the enclosed mounting disk to mount your unit to the dashboard. California 
drivers, use the enclosed disk to comply with California regulations: see the nüvi 
Product Information Sheet that came in the box for more information. 

Important: The permanent mounting adhesive is extremely difficult to remove after 
it is installed. 

To install the mounting disk:
1. Clean and dry the dashboard where you will place the disk.
2. Remove the backing from the permanent mounting adhesive on the bottom of 

the disk and place the disk on the dashboard.
3. Place the suction cup mount on top of the disk
4. Flip the suction lever down to secure the suction cup mount to the disk.
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Disk

Suction cup mount

Suction lever

Removing the Unit and the Mount
1. To remove the unit from the mount, press the tab on the bottom of the cradle 

up. 
2. Lift the unit off of the mount.
3. To remove the suction cup from the windshield, fl ip the lever toward you. 
4. Pull the tab on the suction cup toward you.

Removing the Cradle from the Mount
To remove the cradle from the mount arm, turn the cradle to one side. The cradle will 
snap off the ball socket. 

To replace the cradle, snap the cradle on the ball socket. 
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Custom  POIs (Points of Interest)
Your nüvi accepts custom points of interest ( POI) databases, available from various 
companies on the Internet. Some custom POI databases contain alert information 
for points such as  safety cameras and  school zones. Your nüvi can notify you with a 
proximity alarm when you approach one of these points.

After downloading your POI database, use the Garmin POI Loader to install the POIs 
into your unit. The POI Loader is available at http://www.garmin.com/products/nuvi. 
Select Updates and Downloads. 

Using the POI Loader program, you can store the Custom POIs on your “nuvi” drive 
or your SD card. You can also customize the proximity alert settings for each POI 
using the POI Loader. Refer to the POI Loader Help File for more information; press 
F1 to open the Help File. 

To view your Custom POIs, touch My Locations > Custom POIs. 

To  delete the Custom POIs from your nüvi, touch Where To? from the Menu page. 
Touch My Locations > Delete All. Touch Yes to delete all of your Favorites and your 
Custom POIs. 

Adjusting the   Proximity Alarms
To turn on or off the proximity alarms, from the Menu page, touch  > System > 
Proximity Alarms. 
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When the Proximity Alarms are on, your nüvi chimes when you approach a Custom 
POI. 

 CAUTION: Garmin is not responsible for the consequences of using a custom POI 
database or the accuracy of the safety camera or other custom POI database. 

Caring for Your nüvi 
Your nüvi contains sensitive electronic components that can be permanently damaged 
if exposed to excessive shock or vibration. To minimize the risk of damage to your 
nüvi, avoid dropping your unit and operating it in high shock/vibration environments.

Cleaning the Unit
The nüvi is constructed of high quality materials and does not require user 
maintenance other than cleaning. Clean the unit’s outer casing (not the touch screen) 
using a cloth dampened with a mild detergent solution and then wipe dry. Avoid 
chemical cleaners and solvents that can damage plastic components.
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Cleaning the Touch Screen
Clean the touch screen with a soft, clean, lint-free cloth. Use water, isopropyl alcohol, 
or eyeglass cleaner, if needed. Apply the liquid to the cloth and then gently wipe the 
touch screen.

Protecting Your nüvi
Follow the cautions below to protect your nüvi from damage:

• Do not store the nüvi where prolonged exposure to extreme temperatures can 
occur (such as in the trunk of a car), as permanent damage may result. 

• Do not expose the nüvi to water. Contact with water can cause this unit to 
malfunction.

• Do not leave your nüvi in plain sight when you leave your vehicle. Take your 
unit with you or remove it from view to avoid theft.

• Though a PDA stylus can also be used to operate the touch screen, never 
attempt this while operating a vehicle. Never use a hard or sharp object to 
operate the touch screen or damage may result. 

Using the nüvi Indoors
Close the antenna to turn off GPS and use your nüvi indoors. Use this setting when 
you are practicing using the unit or using the Travel Kit features, such as using the 
MP3 player. 

Using a Remote Antenna
You can use an optional external remote antenna (Garmin GA 27C). This is very 
helpful when operating the unit in a vehicle with a coated windshield or an in-screen 
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(in the window) heating system, which can block GPS signals. Connect the antenna to 
the connector located on the back of the nüvi. To purchase, go to the Garmin Web site 
at http://www.garmin.com/products/nuvi and select the Accessories link. 

Changing the Fuse
An AGC/3AG 2 Amp, high-breaking capacity, 1500 A-rated fuse is located at the tip 
of the vehicle adapter. Periodically, you may need to change the fuse. Unscrew the 
black, round end piece and replace the fuse. 

Unscrew

Charging the nüvi
You can charge the nüvi using the USB cable (see page 17) or the 12/24-Volt car 
adapter connected to the suction mount. 

U pdating the nüvi  Software
Garmin periodically updates its software and map data. If you register your unit, 
you will receive notifi cation of software and map updates. To see if an update to the 
nüvi’s system software is available, go to http://www.garmin.com/products/nuvi and 
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select Software Updates. To see if an update for your map software is available, go to 
http://www.garmin.com/unlock/update.jsp. 

Purchasing Additional MapSource Maps
You can purchase additional MapSource map data from Garmin and load the maps on 
your nüvi’s internal memory or on an optional SD card. Follow the instructions that 
came with the new map data to properly install the maps to your computer and nüvi. 
In order to enable additional maps, you need your unit ID (see page 38) and serial 
number (see page i). To load maps to your nüvi memory or SD card, select the name 
for your “nuvi” drive or SD card drive. Refer to the MapSource help file for more 
information about using MapSource and loading maps on your Garmin GPS. 

Loading MapSource Waypoints on Your nüvi
Using MapSource, you can save locations (also called waypoints) and transfer them to 
your nüvi. For more information about creating waypoints in MapSource, see the help 
file (press F1 to open the help file). 

After you have created the waypoints, select File > Save. Select GPS eXchange 
Format (*.gpx) for the Save as Type. Click the Save button. 

With your nüvi connected to your computer, copy the *.gpx file into in the Garmin\
Waypoints folder in the “nuvi” drive. The waypoints you created in MapSource are 
now in My Locations > Favorites. 
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Viewing Your Saved Locations in MapSource
You can also view the locations you have saved in your nüvi using the MapSource 
program. 

In MapSource, select File > Open. Select GPS eXchange Format (*.gpx) for Files 
of Type. Browse to find the Garmin\Waypoints folder on your “nuvi” drive. Select 
Waypoints.gpx and click Open. 

USB Interface Troubleshooting
Problem/Question Solution/Answer

How do I know my 
nüvi is in USB Mass 
Storage Mode?

When your nüvi is in USB Mass Storage Mode, a picture 
of a nüvi connected to a computer is shown. Also, you 
should see a new Removable Disk Drive listed in My 
Computer. 

My computer never 
senses that the nüvi 
is connected.

1. Unplug the USB cable from your computer. 
2. Turn the nüvi off and then back on again. 
3. Plug the USB cable into your computer. The nüvi 

automatically turns on and goes into USB Mass 
Storage Mode. 

The nuvi cannot communicate with Windows® 95, 
Windows 98, or Windows Me.
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I cannot find any 
drives named “nuvi” 
in my list of drives.

Try the solution listed above. 

If you have several network drives mapped on your 
computer, Windows may have trouble assigning drive 
letters to your nüvi drives. Follow the steps on the 
following page to assign your drive letters. 

I keep getting a 
message saying 
“Unsafe Removal 
of Device” when 
I unplug the USB 
cable.

When you are ready to disconnect your nüvi from your 
computer, double-click the Unplug or Eject  icon in 
your system tray. Select “USB Mass Storage Device” and 
click Stop. Select the nüvi drives and click OK. You can 
disconnect your nüvi from your computer now. 

How can I rename 
my nüvi drives?

1. Open My Computer. 
2. Select the drive you want to rename. 
3. Right-click your mouse and select Rename. 
4. Type the new name and press the Return key. 
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How do I map 
my nüvi drives in 
Windows?

1. Turn off your nüvi. 
2. Plug in the USB cable to the nüvi and your 

computer. Your nüvi automatically turns on. 
3. Click Start > Settings > Control Panel > 

Administrative Tools > Computer Management 
> Storage > Disk Management. 

4. Click a nüvi removable disk drive (either the 
internal memory or your SD Card drive). Right-click 
your mouse and select Change Drive Letter and 
Path….

5. Select Change…, select a drive letter from the 
drop-down list, and click OK. 

nüvi Troubleshooting
Problem/Question Solution/Answer

My battery gauge does not 
seem accurate.

Allow the unit to fully discharge and then fully 
charge it (without interrupting the charge cycle). 
See page 57.

The touch screen is not 
responding to my taps 
properly.

Calibrate the screen. From the Menu page, touch 
Settings > Display. Touch the Recalibrate button 
and follow the on-screen instructions. 
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Battery Information 
Your unit contains an internal (non-removable) lithium-ion battery. Contact your local 
waste disposal department for information on properly disposing of the unit. 

Battery Tips
• Your nüvi’s battery should last 4 to 8 hours depending on usage. The battery 

gauge indicates the status of the battery. 
• To extend the battery life, reduce the time the backlight stays on. From the 

Menu page, select Settings > Display > Backlight Timeout to change the 
setting. See page 40.

• To extend the battery life, close the antenna when you do not need to receive 
GPS signals. 

• To increase the accuracy of the battery gauge, fully discharge the battery and 
then fully charge it. You should not need to do this very often. See “Battery 
Gauge” in the side bar for more information. 

• To maximize the life of the lithium-ion battery, do not leave your nüvi direct 
sunlight and avoid prolonged exposure to excessive heat. 

Battery Gauge
The battery icon in the upper right corner of the Menu page indicates the status of the 
internal battery. 
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Battery 3/4 full

Full battery

Battery 1/2 full

Battery 1/4 full

Battery charging  
or connected to  
external power

Periodically, you might notice that the battery gauge is not completely accurate. To 
increase the accuracy of the battery gauge, fully discharge the battery and then fully 
charge it without interrupting the charging. For best results, do not unplug the nüvi 
until it is totally charged. 

About Satellite Signals
Your nüvi must acquire satellite signals to operate. If you are indoors, near tall 
buildings or trees, or in a parking garage, the nüvi cannot acquire satellites. Go 
outside to an area free from tall obstructions to use your nüvi, or close the antenna to 
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turn off GPS and use it indoors. 

When the nüvi has acquired satellite signals, the signal strength bars on the Menu 

page are green . When it loses satellite signals, the bars turn red or 

disappear . 

Touch the signals strength bars in the upper left corner of the Menu page to view GPS 
information. Touch any where on the screen to return to the Menu page. 

GPS 
Status

Speed

Satellite signal 
strength bars

Sky view

Elevation
Direction of 

travel

The sky view shows the satellites you are receiving. The satellite signal strength bars 
indicate the strength of each satellite you are receiving. 

For more information about GPS, visit the Garmin Web site at http://www.garmin.
com/aboutGPS.
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Technical Specifications
Size: 3.87” W x 2.91” H x 0.87” D (98.3 x 73.9 x 22.1 cm)

Weight: 5.1 oz. (144.6 g)

Display: 3.5” (8.89 cm), 2.8” W x 2.1” H (7.2 cm x 5.4 cm);  
320 x 240 pixels; QVGA TFT landscape display with white backlight and anti-glare 
touch screen

Case: Not waterproof or IPXO

Temperature range: 32°F to 140°F (0°C to 60°C)

Data storage: Internal memory and optional Removable SD card. Data stored 
indefinitely

PC interface: USB mass storage, plug-and-play

Power Input: 12/24 VDC

Usage: 15 W max. @ 13.8 VDC

Battery life: 4 to 8 hours depending on usage

Headphone jack: Standard 3.5 mm 

For a complete list of specifications, visit the Garmin Web site at http://www.garmin.
com/products/nuvi/spec.html.
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GPS Performance Specifications
Receiver: WAAS enabled

Acquisition times*: 
Warm: <1 sec 
Cold: <38 sec 
Factory Reset: <45 sec
*On average for a stationary receiver with an open sky view

Update rate: 1/sec, continuous

GPS Accuracy:
Position: <10 meters, typical
Velocity: 0.5 meter/sec RMS

GPS (WAAS) Accuracy:
Position: <5 meters, typical
Velocity: 0.5 meter/sec RMS
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FCC Compliance

The nüvi complies with Part 15 of the FCC interference limits for Class B digital 
devices FOR HOME OR OFFICE USE. These limits are designed to provide more 
reasonable protection against harmful interference in a residential installation, and are 
more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may 
not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

This equipment generates, uses, and can radiate radio frequency energy and may 
cause harmful interference to radio communications if not installed and used in 
accordance with the instructions. However, there is no guarantee that interference will 
not occur in a particular installation. If this equipment does cause harmful interference 
to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one of the 
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
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• Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.
The nüvi does not contain any user-serviceable parts. Repairs should only be made 
by an authorized Garmin service center. Unauthorized repairs or modifications could 
result in permanent damage to the equipment, and void your warranty and your 
authority to operate this device under Part 15 regulations.

Software License Agreement
BY USING THE NüVI, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS 
OF THE FOLLOWING SOFTWARE LICENSE AGREEMENT. PLEASE READ THIS 
AGREEMENT CAREFULLY.
Garmin grants you a limited license to use the software embedded in this device (the “Software”) 
in binary executable form in the normal operation of the product. Title, ownership rights, and 
intellectual property rights in and to the Software remain in Garmin.
You acknowledge that the Software is the property of Garmin and is protected under the United 
States of America copyright laws and international copyright treaties. You further acknowledge 
that the structure, organization, and code of the Software are valuable trade secrets of Garmin and 
that the Software in source code form remains a valuable trade secret of Garmin. You agree not to 
decompile, disassemble, modify, reverse assemble, reverse engineer, or reduce to human readable 
form the Software or any part thereof or create any derivative works based on the Software. You 
agree not to export or re-export the Software to any country in violation of the export control laws 
of the United States of America.
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Limited Warranty
This Garmin product is warranted to be free from defects in materials or workmanship for one year 
from the date of purchase. Within this period, Garmin will at its sole option repair or replace any 
components that fail in normal use. Such repairs or replacement will be made at no charge to the 
customer for parts or labor, provided that the customer shall be responsible for any transportation 
cost. This warranty does not cover failures due to abuse, misuse, accident or unauthorized alteration 
or repairs.
THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING 
ANY LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO 
STATE.
IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR 
INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states 
do not allow the exclusion of incidental or consequential damages, so the above limitations may not 
apply to you.
Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund 
of the purchase price at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND 
EXCLUSIVE REMEDY FOR ANY BREACH OF WARRANTY.
To obtain warranty service, contact your local Garmin authorized dealer or call Garmin Product 
Support for shipping instructions and an RMA tracking number. The unit should be securely packed 
with the tracking number clearly written on the outside of the package. The unit should then be sent, 
freight charges prepaid, to any Garmin warranty service station. A copy of the original sales receipt 
is required as the proof of purchase for warranty repairs.
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Garmin International, Inc. 
1200 E 151st Street, Olathe, Kansas 66062 U.S.A. 
Tel. 913/397.8200  
Fax. 913/397.8282
Garmin (Europe) Ltd. 
Unit 5, The Quadrangle, Abbey Park Industrial Estate, Romsey, SO51 9DL U.K. 
Tel. 44/0870.8501241  
Fax 44/0870.8501251 
Online Auction Purchases: Products sold through online auctions are not eligible for rebates 
or other special offers from Garmin. Online auction confirmations are not accepted for warranty 
verification. To obtain warranty service, an original or copy of the sales receipt from the original 
retailer is required. Garmin will not replace missing components from any package purchased 
through an online auction.
International Purchases: A separate warranty is provided by international distributors for units 
purchased outside the United States. This warranty is provided by the local in-country distributor 
and this distributor provides local service for your unit. Distributor warranties are only valid in the 
area of intended distribution. Units purchased in the United States or Canada must be returned to 
the Garmin service center in the United Kingdom, the United States, Canada, or Taiwan for service. 
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INDEX

Index
Symbols
2 Dimensional  60
3 Dimensional  60

A
About Button  61
Attention Tone  62
Audible Books

transferring  53
Audio version  61
Avoiding road types  62
Avoiding Traffic  62, 65

B
Backlight Timeout  61
Bilingual Dictionaries  48
Brightness  2
Browse the Map  13

C
Calculator  58
Caring for your nüvi  71
Changing the settings  59
Charging the nüvi  73
Clearing User Data  2

Computer connection  38
Connecting the USB Cable  38
Converting Currency  57

updating conversion rates  
57

Currency  57
Current Location, saving  20
Current Route Page  22
Customizing your nüvi  59

language  63
map  60
navigation  62
system setup  60
time  61

Custom POIs (Points of Inter-
est)  70

D
Daylight Saving  61
Delete

character  17
custom POIs  70
files from the nüvi  41
saved places  12
user data  2

Detour, adding  24
Disconnecting your nüvi  39, 76
Disk Drives  39, 40
Driving directions  22

E
Editing saved places (My Loca-

tions)  11
EGNOS  60
Eject USB  39
Expanding your search  15

F
Favorites  11, 19
Files

deleting  41
managing  37
supported types  41
transferring  39

Finding places
by name  17
intersection  26
item on the map  13
saved item  19

Find a place near another place  
15

FM TMC Traffic Receiver  
64–89

Fuse, changing  73

G
Go!  18
Go Home  10
GPS  3, 8, 78

information  80
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INDEX

Green bars  8

H
Help  42

K
Keyboard  17

L
Language Guide  43, 45, 48
Language settings  63
Legend, Bilingual Diction-

ary  48
Locking the Screen  2

M
M4A/M4P  51
Map  14

browse  13
customize  60
zoom  13

MapSource  74
Map Info Button  60
Map software

update  73
version  60

Map symbol  12
Map view  60
Measurements  58
Metric units  60
MP3  51

Mute  2
My Locations  11, 19

Favorites  19

N
“nüvi” drive  39, 40
“nüvi sd”  39, 40
Narrow your results list

spell the name  17
Navigation settings  62
Near Button  15
Next Turn Page  23
North Up  60

O
On-screen keyboard  17

P
PictureIt  62
Pictures  56
POI  70
Present Location, saving  20
Proximity Alarms  61, 70

Q
Quick Settings  2

R
Recalibrate touch screen  62
Removable Disk Drives  39, 40
Reset Max Speed  21

Reset Trip  21
Restoring Settings  59
Routing preferences  62

S
Safety camera database  70
Safe Mode  60
Satellite Signals  8, 79, 80
Save

current location  20
places you find  18, 19

Saved Places
delete  12
edit  11

School zone database  70
Screen shots  62
SD Card  37, 81

disk drive  39, 40
Set your Location  13
Show Map  14, 18
Software version  61
Spell the name of a place  17
Stop navigation  24
Stop USB  39
Storing your nüvi  72
Supported File Types  41
System Setup  60

T
Taking screen shots  62
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For the latest free software updates (excluding map data) throughout the 
life of your  

Garmin products, visit the Garmin Web site at www.garmin.com.

© 2006 Garmin Ltd. or its subsidiaries

Garmin International, Inc. 
1200 East 151st Street, Olathe, Kansas 66062, U.S.A.
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